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How	to	attach	image	in	word	document

1	Click	the	place	in	your	document	where	you	want	to	insert	the	picture.	Word's	insertion	cursor,	a	vertical	blinking	bar,	will	appear	at	this	point.	When	you	insert	the	image,	its	bottom-left	corner	will	be	at	this	point.	This	method	works	for	all	modern	versions	of	Word	beginning	with	Word	2016.	You	can	also	use	it	as	a	guide	for	earlier	versions	of
Windows,	although	there	will	be	fewer	tools	and	features.	2	Click	the	Insert	menu.	It's	near	the	top	of	Word	between	"Home"	and	"Draw"	(or	"Home"	and	"Design"	in	some	versions).	3	Click	the	Pictures	tool.	It's	in	the	"Illustrations"	section	of	the	toolbar	running	along	the	top	of	Word.	Some	location	options	will	appear.	If	you're	using	Word	2019	or
later,	a	menu	will	expand.	If	you're	using	Word	2016	or	earlier,	your	file	browser	will	appear.	4	Select	the	location	where	you	saved	your	photo.	Word	2019	or	later:	Click	This	Device	if	the	picture	is	on	your	computer.	Click	Stock	Images	to	select	a	free	stock	image	from	Microsoft's	collection.	Click	Online	Pictures	to	use	Bing's	image	search	to	find
photos	on	the	web.	If	the	photo	is	on	your	OneDrive,	select	Online	Pictures	and	click	OneDrive	at	the	bottom-left	corner.	Word	2016:	If	the	picture	is	on	your	computer,	simply	navigate	to	it	in	the	file	browser.	If	you	want	to	search	for	a	photo	online	or	insert	one	from	Facebook,	Flickr,	or	your	OneDrive,	close	the	file	browser	and	click	the	Online
Pictures	icon	next	to	the	"Pictures"	in	the	toolbar.	You	can	then	select	an	image	from	Bing	image	search,	Flickr,	or	Facebook.	If	the	picture	is	on	your	OneDrive,	click	Online	Pictures	instead	of	Pictures	and	click	Browse	next	to	"OneDrive."	5	Select	the	image	you	want	to	insert.	When	you	find	the	picture,	click	it	once	to	select	it.	If	you're	selecting	from
stock	images	or	online	images,	you	can	click	multiple	pictures	to	add	more	than	one.	If	you're	choosing	files	from	your	computer	and	want	to	add	more	than	one	picture,	hold	the	Ctrl	button	down	as	you	click	each	image.	6	Click	Insert.	It'll	be	near	the	bottom-right	corner	of	the	window	no	matter	where	you've	selected	your	image(s).	7	Resize	the
picture.	If	you	want	to	increase	or	reduce	the	picture's	size,	click	it	once	to	select	it,	and	then	drag	any	of	the	corner	circles	in	or	out.[1]	You	can	also	specify	the	size	if	you	want.	Double-click	the	picture	to	open	the	Picture	Format	tab	at	the	top,	and	then	set	your	desired	measurements	next	to	"Height"	and	"Width."	8	Use	the	curved	arrow	at	the	top
of	the	picture	to	rotate	it.	It's	above	the	dot	at	the	top-center	part	of	the	picture.	To	rotate,	place	the	mouse	cursor	over	the	curved	arrow,	and	then	click	and	drag	the	cursor	left	or	right	until	you're	satisfied.	9	Double-click	the	picture	to	access	more	editing	tools.	This	opens	the	"Picture	Format"	(2019	and	later)	or	"Format"	(2016)	tab	at	the	top	of
Word.	On	this	tab,	you	can:	On	the	"Arrange"	panel	in	the	top-right	area,	click	Wrap	Text	to	choose	how	to	situate	the	picture	in	blocks	of	text.	You	can	also	set	alignment	preferences	here.	To	crop	the	picture,	click	the	Crop	tool	in	the	"Size"	panel	at	the	top-right	corner.	The	"Adjust"	panel	near	the	top-left	corner	has	additional	tools	for	background
removal,	color	effects,	and	corrections.	To	add	a	border	or	effect	around	the	picture,	select	one	of	the	"Picture	Styles"	at	the	center	of	the	Format	bar,	or	choose	any	of	the	other	options	in	the	section	to	have	more	control	over	the	style.	1	Click	in	the	document.	Do	so	near	the	place	you	want	to	insert	the	picture.	2	Click	the	Insert	tab.	It's	at	the	top	of
the	window.	3	Click	Pictures	on	the	left	side	of	the	tool	bar.	In	some	versions	of	Word,	you	may	need	to	click	Insert	in	the	menu	bar	at	the	top	of	the	screen,	then	select	Pictures.	4	Select	a	location	from	which	to	add	the	image.	Click	From	File…	to	locate	and	select	the	image	file	on	your	computer.	Click	Photo	Browser…	if	you	want	Word	to	search	for
image	files	on	your	computer.	5	Click	the	image	you	want	to	add.	6	Click	Insert.	The	image	will	be	placed	in	the	Word	document	where	you	clicked.	1	Find	an	image	you	want	to	copy.	It	can	be	from	the	Web,	another	document,	or	your	photos	library.	2	Right	click	on	the	image.	3	Click	Copy.	If	your	Mac	doesn't	have	a	right	click	function,	Control+click
or	click	with	two	fingers	on	your	trackpad.	4	Right-click	in	the	document.	Do	so	near	the	place	you	want	to	insert	the	picture.	5	Click	Paste.	The	image	will	be	placed	in	the	Word	document	where	you	clicked.	1	Locate	the	image	you	want	to	add.	Find	the	image	file	on	your	computer	in	a	folder,	a	window,	or	on	your	desktop.	2	Click	and	hold	on	the
image	file.	3	Drag	it	into	an	open	Word	document	and	release	the	click.	The	image	will	be	placed	in	the	Word	document	where	you	dropped	it.	Add	New	Question	Question	How	do	I	flip	the	whole	image?	Click	on	the	image	and	press	Format.	Then	press	Rotate,	and	then	choose	either	Flip	Horizontal	or	Flip	Vertical.	Question	How	to	get	clip	art	on
Word?	Go	to	the	"Insert"	tab,	which	is	in	between	"Home"	and	"Page	Layout."	Then,	click	on	the	button	that	says	"Clip	Art"	on	it	(between	picture	and	shapes).	A	sidebar	should	pop	up	on	the	right.	From	there,	search	for	the	picture	you	want.	When	you	have	found	the	picture,	double	click	it	and	the	picture	should	appear	in	your	word	document.
Question	What	do	I	do	if	I	can't	import	graphics	into	my	Word	document?	Put	the	cursor	in	document	where	you	want	the	graphic/photo.	Click	on	"insert,"	then	choose	"pictures."	This	should	bring	up	your	photos.	Click	on	the	one	you	want	in	the	document,	and	it	will	be	there.	Ask	a	Question	This	article	was	co-authored	by	our	trained	team	of	editors
and	researchers	who	validated	it	for	accuracy	and	comprehensiveness.	wikiHow's	Content	Management	Team	carefully	monitors	the	work	from	our	editorial	staff	to	ensure	that	each	article	is	backed	by	trusted	research	and	meets	our	high	quality	standards.	This	article	has	been	viewed	246,126	times.	Co-authors:	11	Updated:	May	6,	2021
Views:	246,126	Categories:	Microsoft	Word	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	246,126	times.	There	are	a	lot	of	people	who	see	Microsoft®	Word	as	a	tool	for	just	writing	text	but	are	not	aware	that	you	can	actually	insert	picture	in	Word	documents.	The	truth	is	that	knowing	how	to	insert
image	in	Word	is	very	important	if	you	must	make	a	document	as	illustrative	as	possible.	It	is	important	to	note	that	Word	accepts	a	variety	of	image	formats	and	it	can	also	accept	large	image	sizes.	For	instance,	if	image	size	is	large,	you	can	always	resize	them	keeping	the	overall	size	of	the	document	in	view.	If	you	work	with	Word,	it	is	advisable	to
know	how	to	insert	picture	in	Word	and	this	is	exactly	what	this	article	will	show	you	plus	an	added	bonus	of	inserting	pictures	in	PDF	with	PDFelement.	How	to	Insert	Picture	in	Word	without	Moving	Text	It	is	easy	to	insert	picture	in	Word	with	just	a	few	steps	below	with	the	button	of	"Insert	Picture".	Open	a	new	Word	document	and	go	to	the
"Insert"	tab.	Note	that	anything	that	can	be	inserted	into	a	Word	document	is	located	in	the	"Insert"	tab.	Click	on	the	exact	location	you	intend	to	insert	picture	in	Word	and	then	click	on	"Pictures".	This	will	browse	the	image	file	stored	in	the	system.	Select	the	picture	you	want	to	insert	to	the	document.	Note	that	to	insert	multiple	pictures,	you	can
use	the	Ctrl	button	to	select	each	of	them	by	holding	it	down.	Finally	to	insert	image	in	Word	document,	click	on	"Insert"	and	the	selected	pictures	will	then	appear	in	your	Word	document.	You	have	the	choice	to	resize	it	or	adjust	quality	of	image,	size,	color	and	add	some	effects	if	desired.	PDFelement	is	cost-effective	when	compared	to	other
competitors	that	are	also	great.	One	name	that	comes	to	mind	is	Adobe.	However,	with	PDFelement,	you	can	get	all	the	top	notch	features	of	Adobe	and	the	good	thing	is	that	it	comes	at	a	fraction	of	the	price	of	Adobe.	This	is	why	it	is	regarded	as	the	most	cost-effective	PDF	editor.	After	opening	a	PDF	file	in	PDFelement,	you	can	click	the	"Edit"	tab,
then	click	on	the	"Add	Image"	button	to	insert	a	picture	in	PDF	file	directly.	If	you	want	to	remove	images	from	PDF,	please	check	here	for	more	steps.	Tips:	Word	Format	VS	PDF	Format	We	have	seen	how	to	insert	picture	in	Word,	it	is	time	to	see	how	pictures	can	be	inserted	in	PDF.	This	is	because	as	far	as	office	business	is	concerned,	it	is	almost
impossible	to	avoid	PDF.	It	is	now	one	of	the	most	popular	document	formats	used	all	over	the	word	in	the	sharing	and	distribution	of	digital	documents.	The	reason	for	the	surge	in	popularity	is	attributed	to	its	capability	to	retain	formats	and	its	cross-platform	compatibility.	This	gives	it	a	massive	edge	over	all	other	document	formats	including	word
and	this	is	why	knowing	how	to	manipulate	PDF	to	produce	great	documents	is	desired.	However,	it	is	important	to	note	that	working	on	PDF	including	inserting	pictures	to	it	will	require	you	to	use	a	PDF	editor	and	there	is	actually	no	better	PDF	editor	than	PDFelement	and	you	will	see	why.	It	boasts	of	top-class	features	and	this	is	why	it	is
regarded	as	an	"All	in	One	PDF	Editor".	It	is	capable	of	creating	PDFs	from	scratch,	converting	PDFs	from	one	format	to	another,	editing	PDFs	as	easy	as	editing	word	documents,	and	also	signature	application	to	documents	to	make	it	authentic.	In	addition,	PDFelement	helps	users	with	their	annotation	issues,	extract,	merge,	print	as	well	as	split
PDF	documents.	The	best	part	of	it	is	that	it	allows	for	password	protection	of	your	documents	and	this	means	your	documents	will	always	be	safe.	It	is	important	to	mention	that	PDFelement	is	very	easy	to	use.	By	this,	it	means	that	you	do	not	need	any	technical	skills	to	use	the	software.	It	is	designed	to	be	easily	used	by	just	anybody.	For	instance,	it
has	a	friendly	user	interface	plus	the	availability	of	drag	and	drop	options	which	makes	it	so	easy	to	use.	Another	very	important	reason	PDFelement	is	classed	as	one	of	the	best	PDF	editors	is	because	of	its	top-class	OCR	function.	OCR	is	Optical	Character	Recognition	and	it	is	used	in	transforming	any	scanned	PDF	document	into	an	editable,
selectable,	and	searchable	document.	This	means	that	you	can	easily	convert	an	image-based	PDF	into	some	useable	text	without	having	to	alter	the	document's	appearance.	Get	more	information	about	how	to	use	PDFelement.	Free	Download	or	Buy	PDFelement	right	now!	Free	Download	or	Buy	PDFelement	right	now!	Buy	PDFelement	right	now!
Buy	PDFelement	right	now!	In	many	cases,	merging	images	is	required	during	your	work	with	MS	Word	document.	For	example	you	want	to	combine	two	pictures	just	for	a	special	effect.	Without	any	help	of	image	editor	such	as	Photoshop,	what	can	you	do	in	Word?	Please	look	at	the	following	instruction.	Merge	multiple	images/pictures	into	one	in
Word	Merge	multiple	images/pictures	into	one	in	Word	1.	Insert	the	images	you	want	to	merge	in	Word.	See	screenshot:	2.	Click	Insert	>	Shapes	>	New	Drawing	Canvas	to	insert	the	drawing	canvas.	3.	Copy	and	paste	the	images	into	the	canvas	and	then	drag	them	to	the	desired	position.	See	screenshot:	Tip:	You	can	select	the	image	in	canvas	and
right	click	to	open	the	right-clicking	menu,	then	specify	the	above	and	below	position	of	the	image	from	Bring	to	Front	or	Send	to	Back	options.	4.	Select	all	the	images	you	want	to	merge	by	Ctrl	+	A,	then	click	Format	>	Group	>	Group.	See	screenshot:	5.	Copy	the	combined	image,	then	click	the	blank	place	on	the	canvas.	Delete	the	drawing	canvas
by	press	Backspace	button,	then	paste	the	combined	image	in	the	document.	Normally,	we	can	resize	one	image’s	size	manually	in	Word	document.	And	it’s	quite	tedious	to	resize	many	images	one	by	one.	But,	with	Kutools	for	Word’s	Resize	Images	utility,	you	can	easily	resize	all	images’	size	to	same	25%,	50%,	…	etc.	or	to	the	same	width	of	selected
image	with	only	one	click!	Click	for	60-day	free	trial!	Relative	articles:	Recommended	Word	Productivity	Tools	Complicated	and	repeated	operations	can	be	done	one-time	processing	in	seconds.	Insert	multiple	images	across	folders	into	Word	document	at	once.	Merge	and	combine	multiple	Word	files	across	folders	into	one	with	your	desired	order.
Split	the	current	document	into	separate	documents	according	to	heading,	section	break	or	other	criteria.	Convert	files	between	Doc	and	Docx,	Docx	and	PDF,	collection	of	tools	for	common	conversions	and	selection,	and	so	on...	Read	More	Download	Now	Purchase	Adding	an	image	or	other	illustration	objects	to	a	Word	document	is	simple,	but
positioning	those	objects	and	getting	them	to	stay	where	you	want	them	can	be	frustrating.	Luckily	Word	has	the	tools	to	make	this	more	manageable	if	you	know	where	to	look.	Let’s	take	a	quick	tour.	A	Quick	Word	About	Text	Wrapping	Before	we	get	to	those	positioning	tools,	though,	you	should	know	a	bit	about	text	wrapping.	By	default,	when	you
insert	images	and	other	illustration	objects	into	your	document,	Word	applies	one	of	two	forms	of	text	wrapping:	“in	line	with	text”	(for	images	and	most	other	illustration	objects)	or	“in	front	of	text”	(for	shapes	and	3D	models).	When	you	set	an	object’s	text	wrapping	to	be	in	line	with	text,	Word	treats	the	object	in	question	as	a	text	character.	If	you
type	or	paste	text	before	or	after	the	object,	it	moves	along	the	line	and	down	the	page	just	like	any	other	text	character.	When	you	set	an	object’s	text	wrapping	to	be	in	front	of	the	text,	the	object	appears	on	top	of	any	text,	and	you	can	move	it	to	any	position	you	want.	Understanding	how	to	wrap	text	around	objects	is	an	important	part	of	getting
objects	positioned	the	way	you	want,	so	if	you’re	not	already	familiar	with	how	it	works,	we	highly	recommend	you	read	our	guide	on	the	subject.	RELATED:	How	to	Wrap	Text	Around	Pictures	and	Other	Illustrations	in	Microsoft	Word	In	this	article,	we’re	using	an	object	for	which	we’ve	set	the	text	wrapping	to	“square.”	The	positioning	tools	we’ll	be
talking	about	apply	to	whatever	type	of	text	wrapping	you’re	using,	but	the	exact	positioning	you’re	able	to	perform	will	depend	on	what	text	wrapping	you’ve	chosen.	Opening	and	Using	the	Position	Menu	With	that	out	of	the	way,	let’s	talk	about	those	positioning	tools.	In	your	document,	select	the	object	with	which	you	want	to	work,	switch	to	the
“Layout”	menu,	and	then	click	the	“Position”	button.	That	button	also	appears	on	the	“Format”	menu	of	the	Ribbon	and	works	the	same	way.	The	Position	drop-down	menu	is	divided	into	two	sections:	“In	Line	With	Text”	and	“With	Text	Wrapping.”	The	“In	line	with	text”	section	only	offers	the	single	default	option,	and	here’s	what	that	looks	like.	The
nine	options	in	the	“With	Text	Wrapping”	section	let	you	select	a	fixed	position	on	the	page	for	your	object,	ranging	from	the	top	left	corner	to	bottom	right	corner.	Here’s	our	image	with	the	“middle	top”	option	selected.	Now	that	we’ve	selected	a	position	our	image	will	stay	there	no	matter	how	the	text	changes.	You	can	delete	text	from	that
paragraph,	rearrange	paragraphs,	add	new	text,	or	whatever	else	you	need	to	do	and	that	image	will	remain	at	the	position	you	selected.	One	thing	to	be	careful	with,	however,	is	that	selecting	the	entire	paragraph	to	which	the	object	is	anchored	will	usually	select	the	object	as	well.	So,	if	you	select	and	then	delete	that	paragraph,	you’ll	delete	that
object,	too.	You	can	see	that	an	object	is	selected	because	it	takes	on	a	gray	color	and	border.	If	you	want	to	delete	the	paragraph	without	deleting	the	object,	you	can	select	the	whole	paragraph	and	then	Ctrl-click	the	object	to	deselect	it.	Deleting	the	paragraph	will	then	leave	the	object	behind.	You	can	also	drag	an	object	to	a	new	location,	and	it
will	stay	fixed	in	that	new	location.	Fine	Tuning	and	Other	Options	for	Precise	Positioning	These	basic	presets	work	well	for	simple	positioning,	and	you	can	drag	your	object	to	a	specific	place	if	you	want.	But	what	if	you	want	to	place	two	images	a	set	amount	apart,	or	keep	your	image	a	particular	distance	from	the	margins?	Word	provides	a	palette
of	options	you	can	use	to	fine-tune	an	object’s	position.	Select	your	object,	head	back	to	Layout	>	Position,	and	this	time	click	the	“More	Layout	Options”	command.	The	Layout	window	should	open	with	the	“Position”	tab	selected.	Here	you	can	customize	to	your	heart’s	content.	Let’s	take	a	look,	starting	with	the	Alignment	options.	These	two	options
(one	for	horizontal	and	one	for	vertical	alignment)	control	how	the	object	is	aligned	in	relation	to	parts	of	the	document.	We	set	our	image	to	the	middle	top	of	the	page	previously,	and	you	can	see	that	choice	reflected	in	the	image	below	with	the	horizontal	alignment	set	to	“centered”	and	the	vertical	alignment	set	to	“top”—both	measurements
relative	to	the	margin	of	the	page.	If	you	want	those	alignments	measured	relative	to	something	other	than	the	page	margin,	you	can	choose	different	options	from	the	drop-down	menus	to	the	right	of	each	option.	In	the	“Horizontal”	section,	you’ll	also	see	a	“Book	layout”	option,	which	is	used	when	your	document	is	in	a	left	page/right	page	format
for	printing	and	binding.	The	options	here	are	quite	simple.	You	can	position	your	object	relative	to	either	the	inside	or	outside	of	the	margin	or	page.	These	options	work	in	tandem	with	the	Layout	>	Margin	options,	especially	the	“Mirrored”	option.	Completing	the	set	are	“Absolute	position”	and	“Relative	position”	in	both	the	“Horizontal”	and
“Vertical”	sections.	These	options	give	you	much	finer	control	over	the	specific	position	of	an	object.	Choosing	an	“Absolute	position”	means	your	object	will	stay	in	that	exact	position	no	matter	what	other	formatting	or	text	you	might	change.	A	“Relative	position”	means	your	object	will	be	placed	relative	to	a	part	of	the	document’s	structure	so	if	that
part	of	the	document	moves,	your	image	moves	with	it	and	stays	in	the	same	relative	position.	This	is	useful	when	you	want	your	image	to	always	be	a	certain	distance	away	from	a	margin,	for	example,	even	if	you	change	the	margin	later	on.	Overlapping	Your	Images	Underneath	the	“Horizontal”	and	“Vertical”	sections	in	the	Layout	window,	you’ll
also	find	a	few	other	options.	Let’s	start	with	the	“Allow	overlap”	option	because	that’s	pretty	simple	and	also	very	useful.	If	you’ve	got	more	than	one	object	in	your	document	and	you	want	some	to	be	able	to	overlap	with	others,	you	need	to—you	guessed	it—enable	the	“Allow	overlap”	option.	This	is	a	“whole	document”	setting,	which	means	it	affects
every	object	in	the	document,	not	just	the	object	that	you	had	selected	when	you	turned	the	setting	on.	This	makes	a	lot	of	sense	if	you	think	about	it,	because	why	would	you	ever	turn	this	on	for	one	image	but	no	others?	Like	all	positioning	options,	“Allow	overlap”	only	applies	to	images	which	aren’t	using	the	“In	line	with	text”	wrapping	style.	Once
you’ve	turned	it	on	you	can	drag	your	images	around	to	overlap	how	you	want.	If	you	want	to	change	which	image	is	in	front	of	the	other,	switch	to	the	“Layout”	(or	“Format”)	tab	and	use	the	“Bring	Forward”	and	“Send	Backward”	options	to	layer	the	images	the	way	you	want.	Understanding	the	“Lock	Anchor”	and	“Move	Object	With	Text”	Options
The	various	horizontal	and	vertical	alignment	options	(and	the	“Allow	Overlap”)	are	pretty	straightforward,	especially	after	you’ve	played	with	them	a	bit	and	seen	the	effect	they	have	on	positioning.	The	“Move	Object	With	Text”	and	“Lock	anchor”	options,	on	the	other	hand,	often	cause	some	confusion,	so	we’ll	take	a	bit	more	time	to	explain	how
they	work.	First	things	first:	When	you	start	experimenting	with	these	two	options,	you	might	notice	that	not	much	happens	no	matter	which	you	choose.	That’s	because	these	options	only	affect	objects	that	don’t	have	a	fixed	position.	When	you	changed	your	image	from	“In	line	with	text”	to	a	different	text	wrapping	style,	a	setting	was	enabled	that
you	probably	missed	unless	you	explicitly	looked	for	it.	This	setting	is	called	“Fix	Position	on	Page,”	and	you	can	find	it	on	the	Layout	(or	Format)	>	Wrap	Text	menu.	When	you	have	the	“Fix	Position	On	Page”	option	turned	on,	the	“Move	object	with	text”	and	“Lock	anchor”	options	in	that	Layout	window	don’t	do	anything.	Those	options	only	work	if
the	image	is	allowed	to	move.	To	use	them,	you	have	to	turn	on	the	“Move	With	Text”	option	instead.	And	that’s	where	the	confusion	usually	sets	in.	The	“Move	With	Text”	option	on	the	Wrap	Text	menu	is	not	the	same	as	the	“Move	Object	With	Text”	option	in	the	layout	window.	So,	go	ahead	and	enable	the	“Move	With	Text”	option	on	the	Wrap	Text
menu	and	then	return	to	the	Layout	window.	Let’s	start	with	the	“Move	Object	With	Text”	option.	This	setting	determines	whether	the	object	will	move	with	the	paragraph	to	which	it’s	anchored.	If	this	setting	is	switched	on,	you	can	add	or	delete	paragraphs	above	the	one	containing	your	object	and	the	object	moves	along	with	its	own	paragraph.	A
quick	example	will	show	this	in	action.	We’ll	start	with	an	image	in	the	text,	set	to	the	“Square”	text	wrapping	option	and	the	“middle	top”	position.	When	“Move	object	with	text”	is	turned	on,	the	image	stays	with	the	original	paragraph	when	we	add	another	paragraph	above.	But	when	“Move	object	with	text”	is	turned	off,	the	image	stays	where	it	is
on	the	page	when	we	add	another	paragraph	above.	This	brings	us	to	the	way	that	Word	marks	an	object	as	belonging	to	a	particular	paragraph—how	it	knows	to	move	the	object	with	the	paragraph	when	“Move	object	with	text”	is	turned	on.	Word	does	this	by	using	an	“anchor.”	You	can	see	the	anchor	when	you	select	an	image.	Note:	If	you	can’t	see
the	anchor	then	go	to	File	>	Options	>	Display	and	make	sure	“Object	anchors”	is	switched	on.	By	default,	the	anchor	is	attached	to	the	paragraph	you	into	which	you	insert	the	object,	but	when	you	move	the	object	to	another	paragraph,	the	anchor	moves	with	it.	Let’s	say	you	have	two	paragraphs:	paragraph	one	and	paragraph	two.	If	your	object	is
in	paragraph	one	and	“Move	object	with	text”	is	switched	on,	your	image	will	move	along	with	paragraph	one.	If	you	drag	your	object	into	paragraph	two,	the	anchor	becomes	attached	to	paragraph	two,	and	then	the	object	will	move	along	with	paragraph	two.	But	what	if	you	wanted	your	object	to	stay	in	the	same	position	on	a	page,	but	always	be	on
the	page	with	its	anchor	paragraph?	This	is	where	the	“Lock	anchor”	setting	comes	in.	When	you	turn	on	“Lock	Anchor,”	you	can	then	move	your	image	to	any	position	on	the	same	page	as	the	anchor	paragraph,	and	the	object	will	stay	in	that	position.	However,	if	you	move	the	anchor	paragraph	to	another	page,	the	object	will	also	move	to	that	page,
but	stay	in	the	same	relative	position	on	the	page.	So,	for	example,	if	you	had	your	object	in	the	center	top	of	the	page	and	you	moved	the	anchor	paragraph	to	another	page,	the	object	would	also	move	to	the	same	page	where	you	moved	the	anchor	paragraph,	but	remain	at	the	top	center	of	that	new	page.	That	covers	image	positioning	in	all	its
glory,	so	next	time	someone	dismisses	Word	as	just	a	glorified	typewriter	that	can’t	handle	images	properly,	you’ll	know	that	they’re	wrong.		So,	so	wrong.
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